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1.  Record Video or Video Clips  
 
There is a variety of equipment that can be used to capture digital videos.  In 
this session, we will use a simple USB webcam and a USB microphone.  If you 
would like to use optional equipment such as a camcorder, see What you Need 
to Make Movies with Windows XP and Movie Maker and Connect Your Video 
Camera  located in the Additional Resources Section at the end of this document.   
 
First, connect the web cam and the microphone to the USB ports on your 
computer.  

 
 
On the computer, open the Logitech Quick cam 
 software 
 
Select the Quick Capture option on the menu 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 



 
 

 

 

Make sure that your image is displayed on 
the screen 
 
 
 
 
 
 
 
 
 
 
Click Record Video and record a short 
welcome message. Click Stop Recording 
when you are finished. 
 
 
 

Your recorded message will appear as a thumbnail with a green border.  Double 
click the thumbnail to preview your message.  Click the “X” at the top right of the 
screen to close the application.  Your video has been saved to the default 
location:C:\DocumentsandSettings\administrator\MyDocuments\My 
Videos\QuickCam.   
 
2.  Save or Import Video Clips to the Computer 
 
The video you just created is already saved in the following location: 
C:\DocumentsandSettings\administrator\MyDocuments\My Videos\QuickCam so 
we can move on to step 3. There are many ways to save and import video onto 
the computer.  See Download Video From Your Camera to Your Computer under 
the Additional Resources section at the end of this document.  
 
 
 
 



 3.  Import Video Clips into Movie Maker 
 
 
In this step we will import your newly created videos into the Movie Maker 
Software following the instructions in the Create and Trim Video Clips   
document.   
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Create and trim video clips
Updated: August 8, 2006

When you download video from your camera to your computer, Windows Movie Maker splits your video (which might be a full hour 

long) into shorter clips that are easier to work with, and then adds the clips to a collection. Each time you stopped or paused recording 
with your video camera, Movie Maker created a separate clip.

If you notice that Movie Maker did not break your video into clips, you might have cleared the Create clips for video files option, 
which is selected by default. Follow the steps in Create video clips to divide your movie into smaller clips.

Once you have divided your video into clips, you can immediately drag the clips from the collection to your storyboard to create a 

movie. Then you should trim the video clips to show only the most important moments. Follow the steps in Trim video clips to learn 

how to shorten clips on your storyboard.

Create video clips
Clips are automatically created if you select the Create clips for video files check box when you import a video file into Movie Maker. 
If the check box is not selected, the video is imported as a single continuous clip, rather than as a series of shorter clips. Don’t worry; 
you can use the Movie Maker clip detection feature to divide a video file into smaller, more manageable clips.

To import a video file that you have already saved to your computer and automatically create short clips

1.Under Capture Video, click Import Video. 

Windows Movie Maker: Create and trim video clips
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2.On the Import File dialog box, select the Create clips for video files check box (it is selected by default). Click your video file, and 
then click Import.
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3.Movie Maker creates clips from your video file and adds them to a new collection.

If you downloaded a video from your camera but chose not to break it into clips, it’s not too late to make clips. In the Movie Maker 
Collection pane, right-click the video. Then click Create Clips.
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Now you can drag the clips from the collection to your storyboard to create your movie.

Top of page

Trim video clips
When you watch your video clips, you might notice that the camera tends to shake at the beginning and end of each clip. That’s 
because you’re pressing the record or stop button on your camera. Don’t worry—nobody can hold the camera perfectly steady while 
they start and stop recording.

Fortunately, you can fix the problem with Movie Maker by trimming the beginnings and ends of clips. In fact, you can trim clips down to 
just a few seconds each—that’s the best way to make a fun, fast-paced movie. You can choose to either trim clips in your collection or 
trim clips on your storyboard. You should trim clips in your collection if you plan to use the shortened clip in other movies. For 
information about how to trim clips in your collection, read How to work with collections.

If you don’t want to change the clips in your collection, you can trim them while they are on your storyboard.
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To trim video clips

1.Drag clips from your collection to the storyboard at the bottom of the window.

2.Select the clip you want to trim. Then click the Play button on the Preview Monitor.
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3.Let the clip play until it gets to the point where you want to trim it. Then click the Split Clip button on the Preview Monitor. This 
cuts your clip into two separate clips at the current point in the video and adds the new clips to your storyboard.

Note: If you plan to use transitions, leave an extra second at the beginning and end of each clip to allow the clips to overlap.
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4.Delete the portion of the clip you no longer need by right-clicking it and then clicking Delete.

Repeat this process for each clip. You can split clips several times to use more than one moment from a clip. If you do a lot of 
editing, you might find it easier to use the timeline view, which shows you how long each clip will play. To use the timeline view, click 
the Show Timeline button.
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4.  Polish Movie add Special Effects 
 
Windows Movie Maker offers many options for editing your movie and adding 
special effects.  For today we will follow the Let Movie Maker Do It For You  
document. As you work on your final product you may also want to see the 
documents in the Additional Resources Section to learn how to add narration, 
add titles and credits, add music and add special effects and transitions to your 
project.   
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Let Windows Movie Maker create a movie for you
Published: August 8, 2006

You don't have to spend hours editing your home videos with Windows Movie Maker. In fact, you can use Auto Movie to create a 
professional-looking movie with a title screen and background music in just a few minutes. Simply download your video into Movie 
Maker, select an editing style, choose a title and background music, and then let AutoMovie do the work for you.

After AutoMovie has created your movie, you can immediately watch it and share it with your friends. Movie Maker even creates a 
storyboard and timeline for you, so you can do your own editing to polish the work Movie Maker has done.

To use Movie Maker to automatically create a movie

1.Connect your camera to your computer, and download your movies into Movie Maker. Movie Maker will create a collection (a group of 

video clips) from your movies.

2.In the Movie Tasks pane, under 2. Edit Movie, click Make an AutoMovie.
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3.On the Select an AutoMovie Editing Style page, click on a style. Movie Maker will use this style to create your movie.
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Windows Movie Maker: Let Windows Movie Maker create a movie for you

4.Under More options click Enter a title for the movie.
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Windows Movie Maker: Let Windows Movie Maker create a movie for you

5.Type a title for your movie. If you have copied music to your computer that you want to play in the background, click Select audio 
or background music under More options. If you don't want to use music, skip to step 7.
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6.Click Browse, and select your song (the song is probably stored in your My Music folder).

Tip: To learn how to copy songs from a CD, read Quickly Rip CDs to Your Computer. 
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Windows Movie Maker: Let Windows Movie Maker create a movie for you

7.Finally, click Done, edit movie to create the AutoMovie and add the clips to the storyboard/timeline.
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Sit back and relax while AutoMovie edits your video. This process could take anywhere from a few minutes to 20 minutes depending on 
the length of your video. When AutoMovie finishes editing, you can click the Play button on the Preview Monitor to immediately watch 
your video.

AutoMovies are great because they're very fast-paced. However, you'll probably notice that some of your favorite moments were left 
on the cutting room floor. Don't worry, because you have complete control over your video.

To learn how to do your own editing and add narration, read these helpful articles. To learn how to save and share your movie, 

including burning it to a CD or DVD so you can watch it on your TV, check out these articles.
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5.  Save Movie 
 
There are many ways to save your newly created movie.  For today we will save 
the movie to a CD so that you can have a copy of your movie to take with you.  
There are also directions in the Additional Resources section for saving your 
movie to the computer, a DVD, or to a Web page.   
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Connect your video camera to your computer
Published: August 8, 2006

You've shot some video with your new digital video camera, and you want to import it into Windows Movie Maker so that you can edit 
it into a movie to share with your friends. Or, you've got hours of footage on old Hi-8 or VHS tapes that you want to edit and burn to a 
DVD for an upcoming family reunion. Either way, your first step is to connect your video camera to your computer.

The best way to connect your video camera to your computer depends on the type of camera you have. This list starts with the best 
option, so choose the first one that your video camera supports:

Tip: If you have an older video camera, such as a Hi-8, VHS, or VHS-C camera, you will need to connect using analog video (described 
near the bottom of this page).

•i.Link (also known as FireWire or IEEE 1394). The easiest way to connect your digital video camera to your computer is by using 
an i.Link (also known as FireWire or IEEE 1394) cable. If you use an i.Link cable, Movie Maker can do all the work of rewinding your 
video tape and transferring it to your computer. If you don't have a FireWire port on your computer, and you plan to do a lot of video 
editing, then you should consider adding one. It's an easy and fast way to download video. You (or a professional at an electronics 
store) can install an i.Link adapter. To connect your camera to your computer, simply plug one end of the i.Link cable (included with 
your camera) into your video camera, and plug the other end into your computer. 
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•USB. While more difficult and time-consuming to use than an i.Link connection, USB 2.0 will work with many digital video cameras. If 
you use a USB connection, you will need to manually rewind your tape using your camera, press the play button, and then begin 
capturing the video from Movie Maker. You can also use a USB connection to record live video from a webcam. To connect your 
camera to your computer, simply plug one end of the USB cable (included with your camera) into your video camera, and plug the 
other end into your computer.  
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•Memory Cards. Many digital video cameras can capture video and still images to memory cards. The easiest way to connect a 
memory card to your computer is to remove the memory card from your camera and insert it into a memory card reader attached to 
your computer. This is similar to transferring a file between two computers using a floppy disk.  
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•Analog video. Older video cameras, such as Hi-8, VHS, or VHS-C video cameras, were not designed to connect to a computer. 
However, they can connect to a VCR or TV using analog video connections. Typically, these connections are with S-video or composite 
video cables. To connect this type of camera to your computer, use a video input adapter. USB video input adapters are the most 
convenient, but you can also buy internal cards for desktop computers. Then connect both the video and audio feeds from your 
camera to the video input adapter. If the video input adapter does not have an audio input port, connect the audio feed from your 
camera to your computer's line-in or microphone input.  
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You can now store your videos on your computer so they will be ready for whatever you want to do with them. As with any important 
files, it's a good idea to make backup copies of your videos to keep them safe in case anything happens to your computer.
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Download video from your camera to your computer
Published: August 8, 2006

The first step toward creating great home movies is to download your video from your camera to your computer. 
Once you download your video, you can edit it into an exciting movie that you can share with friends across the 
Internet or watch on your TV.

Depending on your camera and connection, there are several different ways to download video from your camera 
to your PC:

•i.Link cable (also known as FireWire or IEEE 1394) connection

•USB cable connection and video footage on a tape

•Video footage on a hard disk or memory card

How to download video using an i.Link/FireWire/IEEE 1394 connection
An i.Link cable is the quickest and easiest way to download your video to your computer.

To transfer your video

1.Connect your digital video camera to your computer using an i.Link cable. For more information, read How to 

connect your camera to your computer. 
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2.Turn your camera on, and set it to playback mode. When prompted, click Capture Video using Windows 
Movie Maker. Then click OK. 
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3.Microsoft Windows Movie Maker starts the Video Capture Wizard. On the Capture Video File page, type a name 
for your video. Then click Next.  
 

http://www.microsoft.com/windowsxp/using/moviemaker/getstarted/DLmovies.mspx?pf=true (4 of 18) [10/8/2007 2:08:54 PM]



Windows Movie Maker: Download video from your camera to your computer

4.On the Video Setting page, accept the default settings by clicking Next.  
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5.On the Capture Method page, click Next. It's easiest to capture the entire tape at once; if sections remain that 
you don't need, you can delete them later.  
 

http://www.microsoft.com/windowsxp/using/moviemaker/getstarted/DLmovies.mspx?pf=true (6 of 18) [10/8/2007 2:08:54 PM]



Windows Movie Maker: Download video from your camera to your computer

6.The Video Capture Wizard rewinds your tape and then begins capturing it. While the tape is being captured, 
you'll see it playing in the Preview window and you'll be able to hear the audio through your speakers. After the 
tape is captured (this usually takes about an hour), the wizard will stop automatically. It always scans the entire 
tape, even if you have just recorded a few minutes of video. If you reach the end of your recording before it 
reaches the end of your tape, click the Stop Capture button, and then click Yes. 
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Movie Maker automatically breaks your movie into clips and adds the clips to a video collection with the name 
you provided. Now you're ready to edit your movie.

Top of page

How to download video using a USB or analog connection
Though a USB cable or analog video connection is not as easy to use as an i.Link connection, you can still 
download video to your computer by manually rewinding your camera, pressing the play button, and then starting 
the capture. 

To download your video
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1.Connect your digital video camera to your computer using a USB cable or analog video connection. For more 
information, read How to connect your camera to your computer.  
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2.Start Movie Maker by clicking Start, pointing to All Programs, and then clicking Windows Movie Maker.  
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3.In the Movie Tasks pane, under Capture Video, click Capture from video device.  
 

4.Movie Maker starts the Video Capture Wizard. On the Video Capture Device page, click your camera. Then 
click Next.  
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5.On the Capture Video File page, type a name for your video. Then click Next.  
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6.On the Video Setting page, accept the default settings by clicking Next.  
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7.On the Capture Video page, use your video camera to rewind or fast-forward to about five seconds before the 
start of the clip that you want to download. Then press the play button on your video camera, and immediately 
click the Start Capture button in the Video Capture Wizard. It's okay if you start capturing too early, because 
you can trim the beginning of the clip later.  
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8.Click Stop Capture at the end of your clip. It's also okay to capture the entire tape at once, because you can 
break it into shorter clips later.  
 

http://www.microsoft.com/windowsxp/using/moviemaker/getstarted/DLmovies.mspx?pf=true (16 of 18) [10/8/2007 2:08:54 PM]



Windows Movie Maker: Download video from your camera to your computer

9.Repeat steps 7 and 8 to capture other clips. When you're done, click Finish. 
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Movie Maker automatically breaks your movie into clips and adds the clips to a video collection with the name 
you provided.
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What you need to make movies with Windows XP and Movie Maker
Published: August 8, 2006

If you are new to making home movies, you picked a great time to start. Making home movies is a great way to capture your 
memories, and video cameras have never been as powerful, easy to use, or inexpensive as they are now. If you have used video 
cameras before, you will be surprised at how much the technology has improved with digital video.

Before digital video With digital video
Video cameras were large and heavy. Many video cameras are small enough to fit in your pocket.
Handheld cameras produced shaky video. Image-stabilization technology steadies handheld video.
You had to carry separate video and still cameras. Most digital video cameras can take still pictures, too.
Video shot indoors was tinted orange. Digital video cameras automatically adjust to different lighting.
Editing video required special training and was expensive. You can edit videos with your home computer and Windows Movie Maker.

Windows Movie Maker 2.1 is included with Microsoft Windows XP Service 
Pack 2 (SP2).

Most home movies were long and boring. Edited home movies are fast-paced and professional-looking.
To show a video to a friend, you had to ship him or her a 
tape.

You can e-mail videos to your friends, or burn your home movies to a CD 
or DVD.

To edit home movies with your computer so that you can burn them to a CD or DVD, or e-mail them to your friends, you need the 
correct equipment. The following list will help you select the right equipment for the job.

Required Equipment:

•MiniDV digital video camera

•MiniDV tapes

•Computer that supports a digital video connection

•Microsoft Windows XP with Service Pack 2, which includes Movie Maker 2.1

•i.Link port (also known as FireWire or IEEE 1394) on your computer

Recommended accessories for camera:

Windows Movie Maker: What you need to make movies with Windows XP and Windows Movie Maker
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•Memory card

•Tripod

•Wide-angle lens

•Spare battery

•On-camera light

Recommended accessories for computer:

•External USB (Universal Serial Bus) hard disk drive

•DVD burner with writeable DVD media

•Headphones

The sections that follow give some advice about choosing the equipment and accessories that are right for you.

Top of page

Digital video camera and accessories
When shopping for a digital video camera, choose a MiniDV camera. MiniDV cameras are the most popular digital video technology, and 
they offer the best compromise for size, quality, and cost. Choose a camera that feels comfortable in your hands and that is small enough 
to carry when you travel. If you have a widescreen TV, look for a digital video camera that can record in widescreen format (also known as 
16:9).
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MiniDV cameras record digital video onto small tapes that are readily available at grocery stores, pharmacies, and electronics stores. The 
availability of MiniDV tapes is important, because you may need to buy additional tapes when you’re traveling.

MiniDV tapes do not play in a VCR. Instead, you can copy the video to your computer and then burn it to a CD or DVD, or you can connect 
your camera directly to your TV.
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When purchasing a digital video camera, consider buying the following accessories to help you make the highest quality home movies:

•Memory card. Most digital video cameras can take still pictures to a memory card. If your video camera kit does not include a memory 
card, you may want to purchase one. 
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•Tripod. A tripod holds your camera steady, eliminating the potential shakiness of handheld video cameras. 
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•Wide-angle lens. A must-have for indoor filming, wide-angle lenses allow you to stand closer to your subjects and capture more people 
in crowded rooms. 
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•Spare battery. Most camera batteries last for only about an hour of filming. To make sure you have power when you need it, purchase a 
spare battery. 
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•On-camera light. You can attach a light to most video cameras to improve video quality when shooting indoors. 
 

Top of page

Computer and accessories
Most modern computers are powerful enough for video editing. The following table lists computer requirements and recommendations for 
using Movie Maker. 

Component Requirement Recommendation
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Processor 600 MHz or higher processor Any processor made in the last three years
Memory 128 megabytes (MB) 500 MB to 1 gigabyte (GB)
Hard disk 2 GB of free disk space 20 GB or more of free disk space
Connection i.Link/FireWire/IEEE 1394 i.Link/FireWire/IEEE 1394
Operating system Windows XP with Service Pack 2 Windows XP with Service Pack 2

If one or more of your computer components does not meet the requirements, consider upgrading it:

•Windows XP and Movie Maker. Windows XP with Service Pack 2 (SP2) includes Movie Maker 2.1. To download and install SP2, visit 
Microsoft Update. 

•i.Link/FireWire/IEEE 1394. The easiest way to connect your camera to your computer is with an i.Link (also known as FireWire or 
IEEE 1394) cable. If you don't have a FireWire port on your computer, you (or a professional at an electronics store) can install an i.Link 

adapter. Your digital video camera kit will include the proper cable. 
 

http://www.microsoft.com/windowsxp/using/moviemaker/getstarted/whatyouneed.mspx (10 of 11) [10/8/2007 3:12:59 PM]

http://go.microsoft.com/?linkid=3646727
http://www.windowsmarketplace.com/results.aspx?text=firewire+adapter&=Go
http://www.windowsmarketplace.com/results.aspx?text=firewire+adapter&=Go


•Memory. Having 512 MB or more of memory will greatly improve how Movie Maker performs. Memory is inexpensive and relatively easy 
to upgrade, so adding memory should be your first consideration if you want to improve the performance of video editing on your 
computer. 

•Processor. Any processor manufactured in the last three years will provide great performance with Movie Maker. Older processors will 
work too, but the video-editing process will take a bit longer. 

•Monitor. Any monitor will suffice for using Movie Maker. If you do a lot of video editing, a 19-inch or larger monitor can make the editing 
process easier by allowing you to fit more tools and clips on the screen. 

•Hard disk. Have at least 2 GB of free disk space before editing videos with Movie Maker. The more videos you save to your computer, 
the more space you will need. If you begin to run out of free disk space, you can easily add an external USB hard disk drive. If you are 

buying a new computer for video editing, buy a larger hard disk drive to provide room for your home movies. 

•DVD burner with writeable DVD media. If hard disk space is limited, you can also move your digital video files to writeable DVDs. 

•Headphones. Consider using headphones during video editing. With headphones, you can hear subtle sounds more clearly than you can 
through speakers. 
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Working with your video clips in Windows Movie Maker 2
Published: April 26, 2005

Related Links

• Movie Maker sample movies
• Windows XP Experiences 

Glossary
• Connecting your camera to your 

PC with Movie Maker 2
• Download video to your PC with 

Movie Maker 2
• Auto-editing and manual editing 

with Movie Maker 2
• Adding music to your home 

movies with Movie Maker 2
• Join the Movie Maker community
• Get answers to your Windows XP 

digital video questions
• Get answers to your Movie 

Maker questions

Download Windows Movie 

Maker

Make movies like the pros. 
Check out the cool effects, 
transitions, and more in 
Windows Movie Maker. 

You've shot hours of footage with your digital video camera. You've captured this footage on your 
computer and maybe you've even edited a few movies. Now what? Read on to find out how to 
organize your collections and clips in Microsoft Windows Movie Maker.

The elements of Windows Movie Maker: Collections, clips, 
projects, and movies

Understanding collections and clips

Collections are libraries that contain the different video, audio, and pictures that you've imported 
into or captured in Windows Movie Maker 2. You can use and reuse items from the collections for 
the movies you create. When you import the digital media files into Windows Movie Maker, the 
different video, audio, and pictures appear as clips within one or more collection folders in 
Windows Movie Maker.

To import existing digital media files

1.On the File menu, click Import into Collections.

2.In File name, enter the path and name of the file you want to import, and then click Import.

3.(Optional) If you want the video files to be separated into smaller clips, select the Create clips 
for video files check box.

A new collection folder is created for each video file you import into Windows Movie Maker. Any 
audio clips or still images appear in the original collection that was selected when you imported 
the audio and still images.

Note: You can import several files at once. For consecutive files, click the first file in the list, 
press and hold down the SHIFT key, and then click the last file in the list. For files that are not 
consecutive, press and hold down the CTRL key, and then click each file that you want to import.

The following figures show how source video files, audio files, and photos appear in Windows 

Working with your video clips in Windows Movie Maker 2
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Explorer and how they appear as clips in different collection folders after the individual files are imported in Windows Movie Maker.

 
Video files in Windows Explorer and Windows Movie Maker.

 
Audio files in Windows Explorer and Windows Movie Maker.

 
Photos in Windows Explorer and Windows Movie Maker.

Understanding projects and source files

After you import audio, video, or pictures into Windows Movie Maker, you can add the individual clips in the different collection folders 
to the storyboard/timeline. The following figures show clips as they appear in the storyboard and timeline views respectively for the 
same project.
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Video clips in storyboard view.
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Video and audio clips in storyboard view.

 
Video and audio clips in timeline view.

The video, audio, and image clips in Windows Movie Maker projects are only references to the files that you've captured or imported 
into Windows Movie Maker. When you edit video or audio in a collection or on the storyboard/timeline in Windows Movie Maker, you do 
not change the original source video or audio file. Editing the clips on the storyboard/timeline or in a collection only determines how 
and when the audio, video, and still images (as well as any titles, video transitions, or video effects) are displayed in that particular 
project.

All content on the storyboard/timeline — including audio, video, still images, and video transitions, video effects, or titles — becomes a 
project. Ultimately, a Windows Movie Maker project file (which has a .mswmm file name extension) is simply a file that contains 
information about what content is used in the project, as well as the timing information about how and when to display the contents on 
the storyboard/timeline in the final saved movie. It does not actually contain your source files. If you save the project, you can then 
later open it in Windows Movie Maker and make more edits at another time.

To save a project
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1.On the File menu, click Save Project.

 

2.In the File name box, type the file name, and then click Save.

The resulting Windows Movie Maker project file is stored on your computer.

 

Important: Since your Windows Movie Maker project file does not contain a copy of the source files that are used in the 
project, if you want to move a Windows Movie Maker project file and edit it on another computer, you also need to copy all of the 
source content to that computer or make sure that the computer has access to the location where the source files are stored.

Saving your project as a movie

After you've saved a project, you can then save the project as a movie file, such as into a .wmv or .avi file, by using the Save Movie 
Wizard. When you do this, all of the files on the storyboard/timeline are encoded into a single digital media video file. You can then 
share this video file with others, and they can watch and enjoy it in a media player, such as Windows Media Player.

To save a movie
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1.On the File menu, click Save Movie File.

 

2.In the Enter a file name for your saved movie box, type a name for your movie. 

3.In the Choose a place to save your movie box, do one of the following:

•Choose the path and folder name from the drop-down list of available places.

•Click Browse to choose a new place that's not already in the drop-down list.

•To create a new folder, click Make New Folder in the Browse For File dialog box, and then type a name for the new folder.

4.On the Movie Setting page, do one of the following:

•To use the default movie setting, click Best quality for playback on my computer (recommended).

The specific setting details, such as the file type, bit rate, display size, aspect ratio, and frames per second displayed in the video, 
are shown in Setting details.

•To use a different movie setting, click Show more choices, and then choose another movie setting from the list.

5.If you want to watch your movie after completing the wizard, select the Play movie when I click Finish check box.

6.After the movie is saved, click Finish.

The resulting movie is saved on your computer.
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You or your audience can then play the movie in a media player, such as Windows Media Player.

 

Top of page

Organizing your collections
By organizing your collections, you can quickly find the content you want to use and reuse in your movies. This can help reduce the 
time it takes you to create and edit your Windows Movie Maker projects. For example, you might choose to create a new collections 
folder that contains only your favorite video, audio, or still image clips.

To do this, create a new collection called Favorites, split or combine video clips in the collection, copy clips into the Favorites collection, 
and then add some or all of those clips to the storyboard/timeline for the project you're working on at that time. And remember, 
collections always appear in Windows Movie Maker. Therefore, you can reuse the clips in your Favorites collection to create many 
different movies simply by arranging the clips in a different order on the storyboard/timeline, as well as by adding titles, video effects, 
or video transitions in different ways at different times to create different movies from the same video and audio content.

To preview a clip
http://www.microsoft.com/windowsxp/using/moviemaker/create/collections.mspx (7 of 11) [10/8/2007 2:15:45 PM]
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1.In the Contents pane, click the clip you want to preview.

2.On the monitor, click the Play button to preview the video or audio clip.

To create a new collection

1.In the Collections pane, click the Collections folder.

2.On the Tools menu, click New Collection Folder.

3.Type a name for the new collection.

To split a video or audio clip

1.In the Contents pane, click the video or audio clip you want to split.

2.Under the monitor, move the slider to where you want to split the clip.

3.Click the Split button on the monitor.
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The resulting video clips now appear in the Contents pane.

 

Note: To position the slider precisely, you can drag the slider to a point before the place where you want to split the clip, click the 
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Play button, and then click the Stop button at the exact point where you want the split.

To combine a split audio or video clip

1.In the Contents pane, hold down the CTRL key, and then select the consecutive clips you want to combine.

Note: To select consecutive clips, click the first clip, press and hold down the SHIFT key, and then click the last clip. To select one 
clip at a time, press and hold down the CTRL key, and then click each clip that you want to combine.

2.On the Clip menu, click Combine. 

 

The resulting video clip now appears in the Contents pane.
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Note: You can also perform this entire procedure on the storyboard/timeline.

To copy a clip in a collection

1.In the Contents pane, click the clip or clips that you want to copy.

2.On the Edit menu, click Copy.

3.In the Collections pane, click the collection you want to copy the clips to, and then click the Contents pane.

4.On the Edit menu, click Paste.
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Add narration
Published: August 8, 2006

Often, home movies don't have much audio. For example, if you filmed your child snowboarding, there might be nonstop action but 
nothing to listen to (except the cheering audience). Or, the audio in the background may be distracting if you're videotaping in a noisy 
area or from a moving car. Fortunately, with Windows Movie Maker, you have two options if you want to make up for the lack of audio: 
you can add or replace the audio with your own narration of the action, or with music.

•Add music. Add music (such as songs copied from a CD) to your movie. This is perfect when you want to create an atmosphere or 

add some energy to your movie.

•Add narration. Record yourself speaking over your movie. This is perfect when you need to describe what's happening on-screen or 
tell stories that happened off-camera.

Note: If you want background music instead of narration, you can use titles to introduce people or describe settings.

To add narration to your movie

1.If you have a desktop computer, connect a microphone. Microphones are available from most electronics stores. If you have a 
portable computer, you can use the built-in microphone. However, you will get a better-quality recording if you connect an external 
microphone. 
 

Windows Movie Maker: Add narration
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2.Download video from your camera to your computer, and add clips from your collection to your storyboard.

3.In Movie Maker, click the Tools menu, and then click Narrate Timeline. 
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4.If prompted, click OK. 
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5.On the timeline, click the clip you want to narrate. You can narrate clips one at a time, or you can narrate the entire movie all at 
once. If you narrate individual clips, you can rearrange them later and keep your narration synchronized. 
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6.Speak normally into your microphone, and adjust the Input level so that the bar is about halfway up when you are speaking. 
 

7.Under Narrate Timeline click Start Narration. 
 

8.Speak into your microphone as Movie Maker plays your movie. You can narrate your entire movie at once or just one clip at a time. 
When you're done narrating, click Stop Narration. 
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9.Movie Maker will save your narration as a separate file. In the Save Windows Media File dialog box, type a name for your 
narration. Then click Save. 
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10.Movie Maker adds your narration to your video. If you only narrated part of your video and you want to add narration to other clips, 
return to step 5.

11.Click Play in the Preview Monitor to watch your movie and listen to the narration. 
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12.If the narration is too loud or too soft in comparison to the movie, right-click the narration on your timeline, and then click Volume. 
If the audio and narration sound good, you can skip the next step. 
 

13.In the Audio Clip Volume dialog box, move the slider to the left to make the narration quieter, or move it to the right to make it 
louder. Then click OK. Return to step 11 to listen to the narration again, and make another adjustment if necessary. 
 

If you don't like the way your narration sounds, don't worry—nobody likes to hear their own voice. Just relax and speak in a normal 
tone, as if you were telling a friend on the phone about your movie. It may take you a few tries to get the timing right so that your 
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narration doesn't go on longer than your movie. If you misspeak often, it might help to write a script that you can read during the 
narration.

To delete narration so that you can re-record it, right-click the narration on the timeline, and then click Delete. You should also 
delete the narration from the collection. 
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Add titles and credits
Published: August 8, 2006

You can use the same techniques that movies and TV shows do to begin and end their films. By using the title and credits feature in 
Windows Movie Maker, you can easily create an interesting title sequence at the beginning of your movie and provide a list of credits at 
the end. You can also place titles in between scenes of the movie.

Opening titles introduce your movie to your audience and provide background information about what they're about to watch. For 
example, a good opening title might be, "Tom's Fourth Birthday Party" or "Hite Family Vacation 2006." You can show a title on a blank 
background or over your first clip.

Credits at the end of your movie provide a more satisfying ending while telling the viewer who was in the movie. This is also a great 
place to thank the people who helped you make the movie. You can show credits on a blank background or over your last clip. In Movie 
Maker, credits are considered a special type of title that can comprise many lines.

Windows Movie Maker: Add titles and credits
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Windows Movie Maker: Add titles and credits

You can also use titles throughout your movie to introduce scenes or describe what is happening on screen. For example, in a vacation 
movie, you might add a title between scenes that reads, "Day 2: The Water Park". Or you can use titles to introduce people. For 
example, the first time each of your family members appears on screen, you might display a title over the video that shows their name.

To add a title screen before your movie
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1.Download video from your camera to your computer, and add clips from your collection to your storyboard.

2.If you want to add a title before, after, or on top of a clip, click the clip on the storyboard or timeline.

3.In the Movie Tasks pane, under Edit Movie, click Make titles or credits.

4.Choose the type of title you want to add.
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5.Click Change the title animation. Notice that you can choose between one-line titles, two-line titles, and credits, which can be 
many lines. You can use credits any time you need to display more than two lines of text, not just at the end of your video.
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6.On the Choose the Title Animation page, browse through the different animations and watch them in the Preview Monitor to 
get an idea of what they'll look like. When you find the animation you want to use, click Change the text font and color.
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7.On the Select Title Font and Color page, choose the color and font you want to use. If you're adding the title over a clip, use a 
dark font color for bright scenes and a light font color for dark scenes. Then click Edit the title text.
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8.On the Enter Text for Title page, enter your text. Then click Done to add the title to your movie.
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9.If prompted to switch to the timeline view, click OK.
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10.In the Preview Monitor, click the Play button to see how your title will look in your video.
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11.If you want to change your title (for example, to change the color of the text to make it more readable), right-click the title on the 
Title Overlay row of the timeline, and then click Edit Title on the shortcut menu.

Remember, you can add titles any time you want the viewer to know what you're showing or who someone on the screen is.
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Add music
Published: August 8, 2006

There's no better way to create a mood or crank up the energy in your home movies than by adding music. If you haven't yet copied 
your CDs to your computer, read Quickly Rip CDs to Your Computer to learn how. With Microsoft Windows XP and Windows Movie 

Maker, you can add any music from your CD collection to your home movies.

To add music to your movie:

1.Download video from your camera to your computer, and add clips from your collection to your storyboard.

2.In the Movie Tasks pane in Movie Maker, under Capture Video, click Import audio or music.

Windows Movie Maker: Add music
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3.In the Import File dialog box, click the name of the song you want to use in the background. Then click Import. This adds your 
song to your collection but does not add it to your video.
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4.Drag the song from the collection to the video clip where you want the music to start playing.

5.If prompted, click OK.
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6.Movie Maker shows your song on the timeline. If the song extends beyond the end of the movie, drag the right edge of the song so 
that it ends at the same time as your movie. Otherwise, the song will keep playing after your movie is done. It's a nice touch to have 
the music stop during a quiet spot so that it doesn't just stop abruptly.

7.Click Play in the Preview Monitor to watch your movie and listen to the background music.
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8.If the background music is too loud or too soft in comparison to the movie, right-click the music on your timeline, and then click 
Volume. If the audio and music sound good, you can skip the next step.

9.In the Audio Clip Volume dialog box, move the slider to the left to make the music quieter, or to the right to make it louder. Then 
click OK. Return to step 7 to listen to the audio again and make another adjustment if necessary.
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Next time you're filming video, think about the background music. For example, if you're filming a football game, see if you can get a 
copy of the team's fight song. If you're on vacation, buy a CD of local music so you can add it to your movie.
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Windows Movie Maker: Add transitions and special effects

Using Windows XP > Movies

Add transitions and special effects
Published: August 8, 2006

Windows Movie Maker includes about 60 transitions and 28 special effects you can easily use to add professional 
touches and visual interest to your movies.

Transitions are how one scene switches to the next. Rather than simply ending one scene and beginning the next, 
you can use Movie Maker transitions to insert fades, flips, dissolves, and other dramatic shifts between scenes.

Special effects change the appearance of a video clip by rotating it, slowing it down or speeding it up, or making it 

appear like old film footage. Like transitions, you can easily add special effects to your movie by dragging the 
relevant special effect icon onto your movie timeline.

How to add a transition
Transitions do cool things as your movie switches from one scene to the next.

Note: In most movies and TV shows, there are no transitions; scenes simply advance from one to the next. 
Therefore, for the most professional appearance, don't use any transitions. Home movies are supposed to be fun, 
though, so use all the crazy transitions you want. However, remember your audience: you might want to use just 
use a few so you don't overwhelm your viewers.

To add a transition between two movie clips

1.Download video from your camera to your computer, and add clips from your collection to your storyboard.

2.In the Movie Tasks pane, under Edit Movie, click View video transitions.
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3.Preview transitions by double-clicking them and watching the Preview Monitor. Once you've found a transition 
you like, drag it from the Video Transitions pane, under Edit Movie pane to the box between two of your 
clips. This inserts the transition between the two clips.
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4.In the Preview Monitor, click the Video Transitions pane, under Play button to watch your transition in action. 
If you don't like it, just return to the previous step to replace it with a different transition.
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If you decide not to use any transition, right-click it on the storyboard, and click Delete.
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Transitions cause your video clips to overlap by about one second, which means you won't see all of the first or 
last second of your clip. So, when you're filming, it's good to start the camera a few seconds before the action 
starts, and to keep filming for a couple of seconds afterward so that you have time to transition between 
scenes. This also helps you get a steadier shot. If you don't need the extra time in a clip, you can trim it from 

your clip in Movie Maker.

Top of page

How to add a special effect
You can use special effects to change how your clips play in several different ways:

•Speed up a clip using Speed Up, Double, or slow down a clip using Slow Down, Half.

•Zoom in using Ease In, or zoom out using Ease Out.

•Make a clip appear older by using Sepia Tone, Film Age, or Grayscale.

•Rotate a clip using one of the Rotate effects (perfect if someone accidentally holds the camera sideways).

•Fade in using one of the Fade In effects, or fade out using one of the Fade Out effects.

•Fix exposure problems using Brightness, Decrease or Brightness, Increase.

To add a special effect

1.Download video from your camera to your computer, and add clips from your collection to your storyboard.
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2.In the Movie Tasks pane, under Edit Movie click View video effects.

3.Preview effects by double-clicking them and watching the Preview Monitor. Once you’ve found an effect you like, 
drag it from the Video Effects pane to one of your clips. This adds the effect to the clip, which you can see by 
looking at the star in the lower-left corner of the clip.
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4.In the Preview Monitor, click the Play button to watch your effect in action.

You can add more than one effect to a clip. For example, if you want to both brighten a clip and add a zoom 
effect, you can add Ease In and Brightness, Increase. You can also add a single effect multiple times to 
increase the effect. For example, add multiple Brightness, Increase effects to brighten a scene even more, or 
add two Speed Up Double effects to quadruple the speed of a clip.

If you don't like the effect, right-click the star icon in the lower-left corner of the clip, and click Delete Effects.
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Save your movie to a DVD
Published: August 8, 2006

Part of the tradition of home moviemaking is gathering the family around the TV to watch the movie. You don’t have to give up that 
tradition when you make the switch to digital video. You can save a Windows Movie Maker project to a high-quality video file, and then 
burn (or write) that file to a DVD using a DVD burner and video DVD burning program. You can then watch the DVD in almost any 
standard DVD player. DVDs are a great way to share movies with friends and family, and they make great gifts.

To save your movie to a DVD: 

1.Save your movie to your computer.

2.Burn the file to a DVD.

Save your movie to your computer
To save your movie in the ideal video format for burning to a DVD

1.Open your project in Movie Maker.

2.In the Movie Tasks pane, under Finish Movie, click Save to my computer.

Windows Movie Maker: Save your movie to a DVD
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3.The Save Movie Wizard opens. On the Saved Movie File page, type a name for your movie. You can also choose a folder to save it 
in by clicking the Browse button, but My Videos (the default) is usually the best place. Then click Next.
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4.On the Movie Setting page, click Show more choices, then select the Other settings list, and click DV-AVI. Then click Next.
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5.Movie Maker saves your movie, which may take several minutes. On the Completing the Save Movie Wizard page, clear the Play 
movie when I click Finish check box, and then click Finish.

If you want to save more than one movie to a DVD, repeat steps 1 through 5 to save a different movie. Then follow the steps in the 
next section to burn the file to a DVD.

Top of page

Burn your movie to a DVD
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To burn a DVD that you can play in a video DVD player, you need to have a DVD burner and video DVD burning software on your 
computer. Many new computers come with an internal DVD burner. However, if your computer does not already have one installed, 
you may find it easier to install an external USB DVD burner.

You can choose from a number of programs for burning video DVDs, such as Roxio MyDVD. Keep in mind that every program is 

different, but the basics are the same. These instructions show you how to create a DVD using Roxio MyDVD 8.

To burn a movie to a DVD

1.Insert a blank, writeable DVD into your DVD drive.
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2.Click Start, then click All Programs, point to Roxio MyDVD, point to DVD and Video, and then click MyDVD.
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3.In the MyDVD window, under Menu Tasks, click Add New Movie.

4.In the Select Media File dialog box, choose your video, and then click Open. If you want to add more than one video, return to the 
previous step and add more movies.
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5.In the MyDVD window, click the File menu, and then click Burn project to disc.

6.In the Burn Project dialog box, make sure the Burn to disk check box is selected, and then click Burn.
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7.MyDVD burns your movie to a DVD, which will take several minutes. After MyDVD finishes, it automatically plays the movie. Close 
the movie, and then click OK in the Burn Project dialog box.
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You can now eject the DVD and play it in a standard DVD player. Be sure to label it with a permanent marker so that you can identify it 
later. To burn another copy of the DVD, insert another writeable DVD, and then return to step 6.

Note: While most new DVD players support most types of writeable DVDs, some older DVD players can have problems playing custom 
DVDs. DVD-R or DVD+R are compatible with most players. DVD-RW and DVD+RW media are only supported by newer DVD players 
that specifically support rewriteable discs.
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Save your movie to your computer
Published: August 8, 2006

Saving a movie that you created in Windows Movie Maker as a file on your computer will give you the highest-quality movie file. Later, 
you can watch the movie by double-clicking it, which opens and plays it in Windows Media Player. Computers will probably always 
support common video formats, so saving your video to your computer is also a great way to make sure it will always be accessible.

To save your movie to your computer

1.Open your movie in Movie Maker.

2.In the Movie Tasks pane, under Finish Movie, click Save to my computer. 
 

Windows Movie Maker: Save your movie to your computer
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3.The Save Movie Wizard appears. On the Save Movie File page, type a name for your movie. You can also choose a folder to save it 
in by clicking the Browse button, but My Videos (the default) is usually the best place to save your movie. Then click Next. 
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4.On the Movie Setting page, click Next to accept the default setting of Best quality for playback on my computer. 
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5.Movie Maker saves your movie, which might take several minutes. On the Completing the Save Movie Wizard page, click Finish. 
If Play movie when I click Finish was selected (it is selected by default), the movie will automatically play in Windows Media 
Player. 
 

Now you can watch your videos anytime by opening your My Videos folder and double-clicking your movie. While the movie is playing 
in Windows Media Player, press ALT+ENTER to show the movie in full-screen view. Then press ESC to return to your desktop.

If you want to share your movie across the Internet, the most convenient ways are to send it in an e-mail message or save it to a Web 

site. However, both these methods reduce the video quality so that the movie downloads faster. If you want to share the high-quality 

movie you created by following the steps in this article, you can copy the movie to a CD or store it on a USB flash drive. Then you can 
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share the movie with friends or family members by giving them the CD or flash drive, which they can use to view your masterpiece on 
their own computers.
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Save your movie to a CD
Published: August 8, 2006

After creating a movie in Windows Movie Maker, you can share it with your family and friends in a variety of formats. One of the most 
popular media for sharing movies (and many other types of files on your computer) is the CD. In just a few steps, you can save or 
burn a Movie Maker project to a CD using a CD burner connected to your computer.

Before you begin, make sure to save your movie to the hard disk on your computer for safekeeping.

To save your movie to a CD

1.Open your project in Movie Maker.

2.Insert a blank, recordable CD into your CD burner. 
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3.In the Movie Tasks pane, under Finish Movie, click Save to CD.  
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4.The Save Movie Wizard opens. On the Saved Movie File page, type a name for your movie. Then click Next.  
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5.On the Movie Setting page, click Next.  
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6.Movie Maker saves your movie, which might take several minutes, and then ejects your CD. If you don’t want to make another copy, 
click Finish. If you do want to make another copy, insert a new blank, recordable CD, select the Save this movie to another 
recordable CD check box, and click Next. Then return to step 4.  
 

You can watch your movie by inserting the CD into a DVD player or the CD drive on your computer. Be sure to label the CD with a 
permanent marker. If the quality is not acceptable or your DVD player cannot play the CD, you can save your movie to a DVD instead.
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